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About this course
Objectives of the course
Upon completion of this course you will be able to set and manage 
all dimension and annotation standards contained in the standard
files according to company or projects needs.

Targeted audience
Draftsmen, Drafting Administrators

Prerequisites
CATIA V5 Mechanical Design Fundamentals, knowledge of VB 
scripting

16 hours
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Accessing the Workbench (1/6)

You can access the Drafting Workbench anywhere from :

1    The Start Menu :

2    The File Menu or the New icon in the Standard toolbar : 

or 
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Accessing the Workbench (2/6)

You can add an 
Accelerator to 

access directly the 
workbench by 
pressing a key.

You can also create shortcut to access faster the workbench :

1      Go to Tools Menu and select Customize.

2 Select the Drafting Workbench and add it to the Favorites by 
clicking the right arrow.
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Accessing the Workbench (3/6)

or 

3      Now you can access the workbench by 3 new ways :

or 

Pressing F12 Key in this case

When you start CATIA

Using the Start Menu
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Accessing the Workbench (4/6)

The New Drawing Panel :

You can choose different 
Standards : ISO, ANSI, 
ASME,JIS or your 
company standard

Use this Option to avoid 
displaying this panel when 
accessing the Drafting 
Workbench.
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Accessing the Workbench (5/6)

You can use the New From function to access the Drafting 
Workbench by using an existing drawing with a predefined 
format :

This is a new Drawing and 
you can save it without 
keeping any links with the 
selected file.

1      Go to File Menu and select New From.

2      Select an existing drawing to use it as reference.
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Accessing the Workbench (6/6)

When you have accessed the Drafting Workbench you can still make modifications on the Format, 
the Orientation or the Background using the File/Page Setup command:

You can choose to apply the 
modifications on the current 
sheet or on all the sheets of the 
drawing.

Change the Format

You can insert a background 
view from a selected sheet of an 
other drawing document.

Change the Standard and update the 
drawing with this new Standard.
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Toolbars Description (1/6)

Default values are defined in the 
standard styles. After text creation 
you can change the default values 
by selecting a font, a size, an 
alignment, etc.

1      The Text Properties Toolbar :

Be careful, these two 
specifications are applied at 
the dimension creation.

You can select a frame 
around the text or a 
dimension.

You can add some 
symbols in the text. It 
allows you to add a 
prefix symbol to a 
dimension.

Select the anchor 
point position of 
the text.

You can use different Fonts as 
Postscript, True type and V4 type. 

Text alignment
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Toolbars Description (2/6)

2      The Dimension Properties and Numerical Properties Toolbars:

You can modify the 
dimensional representation 
of the dimension.

Default values are the one defined 
in the drafting standards. After 
dimension creation you can choose 
different values.
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Toolbars Description (3/6)

3      The Graphic Properties Toolbar : You can copy the format of 
one object on selected 
objects.

You can select here the line color, the line thickness, the line
type and point type. When you choose a specification, it will 
be applied on all the graphics you will create; it becomes a 
specification by default.

You can also select a graphic then choose a specification to 
apply on it. In this case, this specification won’t be applied on 
the next created graphics.

You can select here a 
pattern for the Area Fill 
function.

In Standards, you 
can add new 
thickness values
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Toolbars Description (4/6)

4      The Tools and Visualization Toolbars:

Here is the standard Tools toolbar. 
It’s a kind of shortcut of the menu 
Tools – Options – Drafting. 

If you want the constraints to be 
created, you must have selected the 
Constraints creation Option before 
to create geometry. 

These Toolbars are specific because they contain some standard functions and displays 
specific information in accordance with the command you select. Most of time, you have to 
drag & drop the Toolbar on the screen to display it entirely.

You can differentiate 2D elements 
(Interactive workbench) from 
generated elements (Generative 
workbench) within the same view.

Dimension system 
selection mode.

A B C D E F G
A

C

B

D

G

E
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Toolbars Description (5/6)

5      The Position and Orientation Toolbar:

You can apply a translation and a rotation to a view, 
a text or a datum.

For a view the reference point is the origin point 
and for a text or a datum, the reference point is the 
anchor point.

This Toolbar is not located on a side of the workbench in the default set-up. You have to go in 
the View/Toolbars command to select it.
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Toolbars Description (6/6)

6      The Style Toolbar :

The styles available in the toolbar 
depend on what your administrator 
specified in the standards.

Create a circle and add a radius 
dimension. The Style toolbar 
displays the styles available for 
radius dimensions. In our example, 
only one style is available, therefore 
it will be used by default.

In the Graphic Properties toolbar, 
select another color, red, for 
example=>In the Style toolbar, an 
asterisk appears in front of the 
selected style: this asterisk 
indicates that the style of the 
element you are creating has been 
overloaded compared to the style 
which is defined in the standards.

• Then you can either revert to the standard-
defined values (i.e. reset the toolbar 
properties to their original values) by re-
selecting this style from the Styles toolbar, 
and then clicking to validate and end the 
dimension creation. The asterisk will 
disappear. 

• Or you can apply the modified style by 
clicking to validate and end the dimension 
creation. For the purpose of this scenario, 
do this.

The dimension is created with the selected 
style, as defined in the standard and 
overloaded by the properties you changed. 

1

2

3
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Hints & Tips on Dress Up Commands

How  to move Axis or Centre Line.

If you select a manipulator you will move the Centre Line and the Axis Line along all the 
directions with the same length. The modification will be symmetric.

If you want to move just one line along only one 
direction and not symmetrically, you can do it by 
selecting the concerning manipulator and holding on 
the Ctrl Key while you are moving the manipulator.

+ Ctrl Key
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Hints & Tips on Dimension Commands (1/13)

The way that you can set and manipulate dimensions 
depends on the options that you have checked in the 
Tools Options Drafting panel. 

By selecting this option, when 
you create a dimension, the 
dimension line is dynamically 
positioned following the cursor.
If you want to deactivate 
temporarily this mode, you can 
do it by pressing the Ctrl Key.

1      The Dimension following the cursor Option:
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Hints & Tips on Dimension Commands (2/13)

2      The Snapping Option :

By selecting this option, when 
you create a dimension, the 
dimension is snapped on the 
grid or/and the dimension value 
to be located at its default 
position between symbols. If you 
want to avoid this, you can do it 
by holding on the Shift Key.

With the Value between symbols option, 
the dimension value will remain in the 
middle of the two extension lines only if 
the mouse cursor stays between the 
two extension lines.

+ Shift Key

You can position the 
dimension value where you 
want.
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Hints & Tips on Dimension Commands (3/13)

3      The Move only selected sub-part Option :

The Move only selected sub-part
option allows you to move only a 
dimension sub-part like a text, a 
line, the dimension value, etc.

For example, you can move the dimension 
value even if you have selected the Snap by 
default option.
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Hints & Tips on Dimension Commands (4/13)

4      The Dimension Circle Option :

By selecting this option, the 
dimension you will create 
between a circle and another 
element will be either on the 
circle center or on the circle 
edge. If you want to change this 
option during the creation, you 
can do it by using the yellow 
manipulator which is displayed.

Select the manipulator with MB1 and 
drag it to choose one of the 3 proposed 
locations. If you have chosen the 
Dimension following the cursor option 
use CTRL KEY.
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Hints & Tips on Dimension Commands (5/13)

5      The Diameter Dimension Options :

During the dimension creation step, you can switch 
between one-symbol or two-symbols dimension.

Once the dimension has been created, 
you must use the Properties menu 
(Dimension Line tab) to specify whether 
you want to use one or two-symbols.

After the Diameter Dimension creation, 
you can swap to Radius Dimension by 
using the contextual menu.
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Hints & Tips on Dimension Commands (6/13)

6       The Angle dimensions Creation :

During angle dimension creation 
you can move the dimension to 
a new sector by using the Angle 

Sector contextual menu 

You can also edit the angle sector of an 
existing angle dimension, by right-clicking 

the angle dimension and selecting the 
Dimension_name object -> Angle Sector

command from the contextual menu. 
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Hints & Tips on Dimension Commands (7/13)

7      The Create driving dimension Option :

Select this Option if you want to 
create driving dimensions by 
default.

During the dimensions creation, 
you can set directly the value in 
the Tools Palette toolbar.
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Hints & Tips on Dimension Commands (8/13)

8      The Line-Up Options:
The Line-Up function allows you to position 
length, distance, radius, diameter an angle 
dimensions according to a given reference.

To define the distance and the angle in 
relation with the reference element.

To define the distance and the angle 
between each dimension you line up.

5mm

10mm

Select the 
reference element

Define de Line-up 
parameters
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Hints & Tips on Dimension Commands (9/13)

9      Creating Chamfer Dimensions :

During the creation of the chamfer 
dimension, you can define the format of the 
dimension and the representation mode in 
the Tools Palette toolbar.

You can also modify those properties 
afterwards by accessing the Chamfer tab in 
the dimension properties.
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Hints & Tips on Dimension Commands (10/13)

10      Creating Coordinate Dimensions :

The Tools palette appears with two options: 
2D Coordinates lets you create 2D (x, y) 
coordinate dimensions for interactive 
geometry, 3D Coordinates  lets you create 
3D (x, y, z) coordinate dimensions for 
generative geometry. 

Coordinates are relative to absolute axis 
system except for view created selecting a 
3D local axis system.

If you need to hide the coordinate 
dimension's unit, you can do so by editing 
the properties of the coordinate dimension.
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Hints & Tips on Dimension Commands (11/13)

11      How to align dimensions during the creation :

Select the 30 dimension while you 
are creating the 25 dimension if you 
want to align the two dimensions.
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Hints & Tips on Dimension Commands (12/13)

12      How to move extension lines :

You want to move just one extension 
line, you can do it by selecting the 
concerning manipulator and holding 
on the Ctrl Key while you are moving 
the manipulator.

If you select a manipulator, you will move the both 
extension line with the same length.

+ Ctrl Key

You can Double Click the manipulator to 
set the Overrun value and you can 
choose to apply this value to one or both 
sides.

You can also use the Properties menu.
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Hints & Tips on Dimension Commands (13/13)

13      Using Manipulators to modify dimensions :

You can modify the size 
of all the Manipulators.

In the Tools Options Drafting panel, you select which 
Manipulators you want to display during the dimension 
creation and when you want to modify a dimension.

You can Click on the Manipulator 
to add directly Text After.

If you let the mouse cursor on a 
manipulator, it will appear a 
contextual help.
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Hints & Tips on Text Commands (1/14)

1      How to snap a Text on a point :

Select the Text and drag it so as to 
the mouse icon encounter the point.

The result depends on the 
Anchor point of the Text 
box. 

If you modify the Anchor 
point of the selected text 
after having snapped it, the 
Text will move in function.
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Hints & Tips on Text Commands (2/14)

2      How to associate a Text to an existing element :

Click on the Text icon and select the 
dimension to which you want to 
associate the text.

If you move the dimension, the text 
will follow and keep the same relative 
position. 

You have two ways to associate a Text to an existing 
element:

- by selecting the geometry at the creation

- by using the Positional link function

Select any part of a created text and 
use Positional Link – Create in the 
contextual menu to select the 
dimension to which you want to 
associate the text.

Or

Remark: You can create a text in a 
view not up to date, but you can not 
associate it to any geometry.
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Hints & Tips on Text Commands (3/14)

3    How to orientate a Text along an existing element :

Select any part of a created text and 
use Orientation Link – Create
command.

Select the line.

If you change the 
line orientation, the 
text will follow.
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Hints & Tips on Text Commands (4/14)

3     How to orientate a Text along an existing element :

At the creation of the Text, you can also use the Shift Key to orientate directly 
the Text if you have selected the Activate snapping option in Tools Options.

If you select Text in Apply snapping to Option, it’s the contrary. The Text will 
be orientated along the geometry by default and you will have to press the 
Shift Key to orientate it horizontally.

Press the Shift Key 
when you select the 
line.

If you change the 
line orientation, the 
text will follow.
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Hints & Tips on Text Commands (5/14)

4     You can predefine the width of the text box at the creation :

Select the Text icon then draw a box 
using MB1.

The width of the Text box is now 
defined.

If your text is too long, it will be 
added an other line automatically 
and the width will be kept.
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Hints & Tips on Text Commands (6/14)

5     You can create Texts vertically directly during the creation :

Select the Text function then press 
CTRL Key when you select the position 
of the Text.

You directly write the Text vertically.

This is also valid for Text with Leader 
and Geometrical Tolerance.
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Hints & Tips on Text Commands (7/14)

6      You can rotate the text box manually :

Select the Free Rotation icon in the 
Select toolbar then select the Text box.

You can select any of the 
manipulators and perform rotation. 

The center of rotation will be the 
Anchor point of the Text box.

You can change the center of rotation 
by modifying the Anchor point.

If you keep pressing the 
Shift Key during the 
rotation, you will rotate 
by step of 15 degrees.
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Hints & Tips on Text Commands (8/14)

7      How to orientate Text with Leader or Geometrical Tolerance at the creation:

You can orientate directly a Text with Leader (or Geometrical Tolerance) perpendicularly to an element 
by using the Shift Key if you have selected the Activate snapping option in Tools Options.

If you select Text with Leader (or Geometrical Tolerance) in Apply snapping to Option, it’s the contrary. 
The Text with Leader (or Geometrical Tolerance) will be orientated perpendicularly to the geometry by 
default and you will have to press the Shift Key to orientate it differently.

When you position the Text with 
Leader (or Geometrical 
Tolerance), press Shift Key to 
orientate it perpendicularly to the 
geometry.

If you move the geometry, this 
properties will be kept.
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Hints & Tips on Text Commands (9/14)

8      How to modify Text with Leader :

You can add/remove a Breakpoint by using the 
contextual menu on the yellow manipulator.

If you have selected 
the Snap to Point 
option, the new break 
point will be created 
on the grid and you 
will be able to move it 
only on the grid. 

You can create/remove multiple leader 
extremities, create/remove interruptions. In 
those cases, by selecting a yellow manipulators, 
you will act on the ascendant branch.

Use Shift Key to 
deactivate this option 
or snap on the grid if 
you haven’t selected 
the option.

These modifications are also valid for all annotations with Leader. 
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Hints & Tips on Text Commands (10/14)

9      How to add leader on 2D Component :

You can add a leader on the 2D 
Component by using the contextual 
menu and selecting Add Leader. Then 
select the geometry where you want the 
arrow to point. 

You have created a 2D Component in a Detail Sheet and you instantiate it in another sheet. 

By default, the origin of the leader 
is at the origin point of the 2D 
Component.
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Hints & Tips on Text Commands (11/14)

10     How to modify the origin point of a leader on 2D Component:

You have only some possibilities 
to change the origin point of the 
leader. It depends on the geometry 
of the 2D Component but it keeps 
quite similar to this example.
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Hints & Tips on Text Commands (12/14)

11     How to modify text in 2D Component instances:
You can modify text 
string and 
properties for each 
instance by using 
the “Modifiable in 
instance” function in 
the contextual menu 
on 2D Component in 
the Detail sheet.

This operation is 
irreversible and all 
the 2D component 
instances texts 
become modifiable.  
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Hints & Tips on Text Commands (13/14)

12     How to fix the text orientation in 2D Component instances:

You can specify text orientation 
in the Properties menu of the 2D 
Component in the Detail sheet.

This operation concerns all the 
2D component instances texts.  

Here is a 
summary table



Student Notes:

Advanced Drafting and Customization
����������	��

Copyright DASSAULT SYSTEMES 45

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Hints & Tips on Text Commands (14/14)

13     How to use Text Replicate :

Here the Text is linked to 
the diameter value of the 
hole in the 3D Part.

This function allows you to replicate a Text. You can also replicate a  
Text with Attribute.

Select the hole in 
the 3D Part then 
enter the Text 
Replicate function.

The new replicated text automatically appears 
under the cursor then click where you want the 
new text to be positioned. You can add leader.

3

1

2



Student Notes:

Advanced Drafting and Customization
����������	��

Copyright DASSAULT SYSTEMES 46

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Hints & Tips on Generative Drafting
You will become familiar with …

Generating Specific Views
Creating Section View/Section Cut with a Profile Defined in 3D
Update Management
Auto-Dimensioning
Advanced Filtering Techniques
Balloon Creation
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Generating Specific Views (1/3)

You can use a 3D local axis as reference for the Front view in the view creation .

After entering the Front View function, you must select the Axis
System in the Specifications Tree before selecting the reference
view plane. This specification is propagated in projection, 
section, auxiliary and detail views.

It is not necessary that this Axis System is the current one.

If you don’t select a local Axis 
System, you will generate a Front 
view with a blue axis system which is 
the projection in the view plane of the 
3D absolute axis system.
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Generating Specific Views (2/3)

The Advanced Front View command allows you to define view name and scale 
at the view creation. This command takes also into account local Axis System 
reference.
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Generating Specific Views (3/3)

The Advanced Front View command allows you to use a DMU Section box to 
specify a 3D clipping view.

Select the Section Feature in the 
specifications tree then a plane.
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Creating a Section View/Section Cut with a Profile Defined in 3D

Defining a profile in 3D to create a section view / Section cut enables you to make the profile 
associative with the geometry, and therefore to drive this profile using dimensional 
constraints.

Depending on the type of profile you sketch and the type of section you want (offset or aligned), 
you can select different icons in the Sections Toolbar. If the 3D profile is not valid for generating 
the appropriate view, you will not be able to select it.

When editing a 3D profile, make sure that you modify it in accordance with the type of section 
(offset or aligned) you created. If an edited profile is invalid when you update a drawing, the 
associated section view/section cut will not be displayed (an error symbol will appear instead).
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Update Management

If you perform modifications in a 3D model which has associated drawings, an update 
will be requested in the drawings. You can update all views or a selection of views.

The Update icon        is active in the 
Update toolbar when a drawing 
contains views that need to be 
updated. You can update all views in 
the active sheet by clicking this icon.

An update symbol        appears in the 
specification tree for the views that 
need to be updated. You can update a 
selection of views by selecting them 
and using the Update Selection
contextual command

Update symbols also appear in the 
specification tree to indicate drawings 
and sheets      containing views that need 
to be updated.

Updating views means:

-re-computing associative section/auxiliary 
view profiles

-re-generating the geometry

-re-computing any annotation/dimension/dress 
up element linked to the generated geometry

-taking into account deleted views or views 
that are graphically modified on the condition 
the view is up-to-date when delete or modify it.

Remarks: you can restore deleted elements by selecting Restore 
Deleted into the contextual menu and then updating the view. You
can either use the Update icon if you modify the 3D model or key in 
C:Force Update if you did not modify the 3D model. 
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Auto-Dimensioning (1/16)

If you use the Generating Dimensions function on a drawing generated  directly 
from an assembly, you will have only dimensions from the assembly constraints 
and not from each Part. Moreover, the generated dimensions are only in relation 
to offset or angle constraints.
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Auto-Dimensioning (2/16)

By selecting this Option, if you have already 
generated dimensions, new dimensions will 
be generated automatically if you update your 
drawing after a modification in the 3D.

Dimension Generation settings: The way that you can generate and manage dimensions 
depends on the options that you have chosen in the Tools/Options/Drafting command, 
Generation tab

Generate dimensions when updating the sheet
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Auto-Dimensioning (3/16)

Select this option if you want to display the 
Dimension Generation Filters panel when you 
enter the Generating Dimensions function. 
This option allows you to select the view in 
which one you want to generate the 
dimensions.

If you don’t select this option, all dimensions 
will be automatically generated when you 
select the Generating Dimensions function in 
all the views.

It’s the same for the Generating Dimensions 
Step by Step function.

Before accessing the Generating Dimensions 
function, you can also use a Trap to define 
the views concerned by the dimensions 
generation.

The Filters before generation option
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Auto-Dimensioning (4/16)

If you chose this option, the Dimension 
Positioning function will be automatically 
executed at the end of the dimensions generation.

If you have already generated the dimensions on 
the drawing and you add an other view, when you 
repeat the Generating Dimensions function, some 
created dimensions will be automatically 
transferred into the new view if that improves the 
clearness of the drawing. 

The Automatic positioning after generation option

The Allow automatic transfer between views option
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Auto-Dimensioning (5/16)

You have to chose this option if you want to 
display the Generated Dimension Analysis 
panel at the end of the dimensions generation.

If you don’t select this option, you won’t have 
any information about the number of 
generated dimensions in relation to the 
number of constraints in the 3D .

The Analysis after generation option
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Auto-Dimensioning (6/16)

Select this option to extract 3D part constraints (on top 
of assembly constraints) when generating product 
dimensions. 
This option is particularly useful if you want to 
generate dimensions for all parts included in assembly 
or product views, without displaying the Dimension 
Generation Filters dialog box before dimension 
generation. Note that if you display the Dimension 
Generation Filters dialog box before generating 
dimensions, you will need to indicate for which parts 
you want to generate dimensions.

The Generate Dimensions from parts included in assembly views
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Generates dimensions from 
constraints with design 
tolerances, and applies the 
constraint tolerance to the 
corresponding generated 
dimension. 

Auto-Dimensioning (7/16)

Generate all the dimensions from 
constraints created in the 
Sketcher workbench.

Generates dimensions from 3D 
constraints

Generates dimensions from 
assembly constraints. This 
option is active only in the case 
of products or assemblies. 

3

Generates dimensions from 
measured constraints

4

Generates dimensions from 
constraints associated with 
elements that are not 
represented on the drawing (i.e. 
which are not visible in the 
various views your drawing may 
contain). In this case, the 
generated dimensions will 
appear as not attached to any 
element in the drawing. 

5

6

Retrieves all the constraints which you 
previously excluded (either using the 
Not Generated icon   when performing a 
step by step generation, or by removing 
a generated dimension from the 
drawing), and re-generates the 
dimension. This icon is active only 
when there are dimensions to retrieve

1
2
3
4

5

6

7

7

The Dimension Generation Filters panel
This panel gives you information about the total number of constraints in 3D and allows you to 
select the kind of constraints that will be taken into account for dimensions generation.

1

2
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Auto-Dimensioning (8/16)

Be careful, this panel gives 
only information from the last 
dimensions generation.

The Generated Dimensions Analysis panel
The Generated Dimension Analysis dialog box displays the number of constraints available in the 
3D, as well as the number of dimensions generated on the drawing, for each part or product in the 
drawing (in this case, there is only one part). You can use the options in this dialog box to 
highlight the dimensions in the drafting sheet as well as the associated 3D constraints you can 
visualize in your Part or Product document.
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Auto-Dimensioning (9/16)

Displays all the constraints for which 
dimensions have not been generated on 
the drawing. 

The Generated Dimensions Analysis panel
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Displays all the constraints which have 
not been taken into account during the 
dimension generation (this can be 
because you previously excluded them 
using the Not Generated icon when 
performing a step by step generation, 
or because you removed a generated 
dimension from the drawing

Auto-Dimensioning (10/16)

The Generated Dimensions Analysis panel
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Auto-Dimensioning (11/16)

Highlights in the drawing all 
generated dimensions.

Highlights the dimensions 
created manually via the 
Interactive Drafting workbench 

Highlights in the drawing the new 
generated dimensions since your 
last dimension generation.

3

1

2

3

The Generated Dimensions Analysis panel

1
2
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Auto-Dimensioning (12/16)

You will display in the drawing all 
generated dimensions.

You can visualize in the 3D the 
constraints corresponding to 
the dimensions to be created on 
the views (zoom automatic).

Buttons allowing you to generate 
the next dimension, to stop the 
step by step generation and to 
generate the remaining 
dimensions in one step, to abort 
the process and to make a pause. You can transfer a dimension to 

another selected view.

You can modify the dimension.

The Step by Step Generating Dimensions panel
The Step by Step Generating Dimensions function is interesting  if you know which dimensions 
you want to generate, if you have finished the drawing layout (all the views are fixed) and if there is 
not to much dimensions to generate.
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Auto-Dimensioning (13/16)

This function takes into account only 
distance & length dimensions and 
diameter dimensions if they are 
represented as side dimensions.

The Dimension Positioning function
This function will position distance and length dimensions (either generated dimensions or 
interactive dimensions) in a better way. These dimensions will be positioned on the active view 
exclusively.
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Auto-Dimensioning (14/16)

You can choose to have either a 
whole or a filtered list with the 
interfering elements. The total 
number of interfering elements is 
automatically updated according 
to your choice.

The Dimension Analysis function 
This function will analyze the dimensions generated from 3D and those created manually and will 
indicate if there are any interferences between them. 
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Auto-Dimensioning (15/16)

Use the scanner to navigate among 
the list of the interfering dimensions.

The interfering dimensions are 
automatically displayed in the 
red orange color.

The Dimension Analysis function 
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Auto-Dimensioning (16/16)

The positioning of the generated 
dimensions depends directly on the 
positioning of the constraints in the 
Sketch. So, if you want to optimize the 
clearness of the drawing, try to create 
your sketch constraints properly

Hints & Tips
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Advanced Filtering Techniques (1/9)

Enter the Front view 
function then select in the 
3D document all the 
parts/products/bodies you 
want to see in the view

3D components selection 
In a Product (or a Part), you can select only the Parts (or Bodies) you want to show in the drawing.
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Advanced Filtering Techniques (2/9)

Right click and select Front view 
object/ Modify Links in the 
contextual menu. Link Modification 
dialog box is displayed. 

In the 3D product, select 
some new parts/products 
and click Add all button.

After drawing update, the 
selected parts/products are 
projected in the front view

1

2

3

After the view creation, you have the ability to modify the list of elements to be taken into account 
in an existing view, by adding or removing sub-products/parts/bodies.



Student Notes:

Advanced Drafting and Customization
����������	��

Copyright DASSAULT SYSTEMES 70

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Advanced Filtering Techniques (3/9)

The Drafting Properties panel 
You have the possibility to apply filters on a Product or a Part in relation to the type of view you want to 

generate. To enable this function, you must first check the Apply 3D specifications drafting setting
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Advanced Filtering Techniques (4/9)

In the contextual menu, if you access the 
Properties panel, you can check 3 
drafting properties. 

You can use the Multi-selection to apply 
the same specifications to several Parts 
of a Product.

The Drafting Properties panel
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Advanced Filtering Techniques (5/9)

Multi-select the screws of the 
assembly and apply them the 
Do not cut in section views 
option.

If you create a section view going 
through the center of the screw, you 
can see that it is not cut.

This option is not available 
on a Product.

The Drafting Properties panel
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Advanced Filtering Techniques (6/9)

Multi-select the parts of the assembly 
you don’t want to see in the drawing 
view and apply them the Do not use 
when projecting option.

If you create a front view of the 
general assembly, you won’t see 
the selected Parts.

This option is not 
available on a Product.

The Drafting Properties panel
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Advanced Filtering Techniques (7/9)

Select  the parts you want to project 
in the drawing view with hidden 
lines and check  the Represented 
with hidden lines option.

If you create a front view of the general 
assembly, you will see the selected 
parts displayed with hidden lines.

This option is not available 
on Products.

The Drafting Properties panel



Student Notes:

Advanced Drafting and Customization
����������	��

Copyright DASSAULT SYSTEMES 75

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Advanced Filtering Techniques (8/9)

Select in the 2D view 
or in the 3D document 
some parts/products 
and you will be able to 
overload some of their 
properties.

1

2

Overload properties
After view creation you can overload the properties of elements generated from a CATProduct. 

Show/Noshow
Use/Unuse
Cut/Uncut
Color
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Advanced Filtering Techniques (9/9)

Click the Edit button to display  the editor 
panel. Modify what is needed.You can multi-select different parts 

in the 2D document or in the 3D 
document. A sub-product can also 
be selected in the 3D document.

4

3

Overload properties
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Balloons Creation (1/2)

Enter the Generate 
Numbering function 
then select the 
assembly.

You can choose between  
Integers or Letters.

1

2

Generate numbering in assemblies
You can generate in the active view balloons corresponding to references defined on the different 
parts of an assembly.
First of all you must generate the numbering in the CATProduct.
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Balloons Creation (2/2)

Active the view where you want 
to add balloons and select the 
Generate Balloons icon.

If needed, multi-select these balloons and 
modify their font size using the Text 
Properties toolbar. 

You can also align them using Element
positioning function.

3

4

Generate balloons
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Drawing Generation of Large Assemblies

General Recommendations
Approximate generation mode
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Always use « Cache management » option
CATIA loads the appropriate 3D data when needed

Adapt view generation mode to your needs
Exact/CGR/Approximate/Raster

Use Occlusion Culling option
The Occlusion Culling option activates a pre-processing during view update, in order to determine 
which parts in the assembly will be hidden in the view.
This allows to avoid un-necessary operations during view update.
In Exact projection mode, it avoids loading geometry of hidden parts (they stay in visualization 
mode).
In All projection modes, it avoids computing the projection and HiddenLineRemoval operation for 
these hidden parts.
This options leads to Memory and CPU gains.
This option is available as a property of views and in Tools/options for the default value.

General recommendations (1/2)
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General recommendations (2/2)

Use Only generate parts larger than option:

Remove parts that are under a size defined in Tools/Options.

This parameter works for all generation modes (exact, CGR, Approximate, Raster).

This option is available as a property of views and in Tools/options for the default value.
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Approximate generation mode (1/3)

Visu-mode
assembly data

Visu-mode
Assembly data

View update 
memory peak

M
em

or
y

CGR Approximate

“Approximate” generation mode 
Similar to CGR generation mode
Generation mode available in Drafting settings
Works on visu-mode assembly data (cache mode active)

Uses specific algorithm for projecting geometry
Reduces memory needed to update the view

Memory peak is less than 10% of assembly data size in memory
Memory allocation during update 10 times less compared to CGR mode
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Approximate generation mode (2/3)

Dimensions and dress-up elements
By default dimensions and dress-up elements are not associative to 3D. A specific setting must  
be checked.
The minimal geometrical information needed to create the associativity will be loaded (Selective 
Loading protocol).
The dimensions will measure the 3D elements, not the Approximated projected 2D elements.
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Approximate generation mode (3/3)

Limitations 
No Thread generation
No Dimension generation
No Axis lines and Center-lines
No Fillet representation
No Detail Views
You cannot project 3D elements such as wireframe, points 
Breakout profile has to be parallel to projection plane (no application of existing breakout on 
isometric views)
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Administration tasks
Administrators can manage and customize standards such as ISO, JIS, ANSI, 
ASME, etc. or company standards. The Standards Editor lets administrators set 
the standards used for dress-up, dimensions, annotations, etc. as well as set 
the styles that will be used as defaults for element properties in the Interactive 
Drafting workbench. 
In the Generative Drafting workbench, administration tasks consist in 
managing and customizing the styles that will be used to generate views using 
the standard Editor (generative view styles)

About Standards and generative View styles 
Administration of Generative View Styles and Standards
Setting standard parameters
Setting standard styles
Setting Generative View Style parameters
Administration Settings
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About Standards and generative View styles (1/2)

When users modify the properties of an element in the Interactive Drafting workbench, the 
modifications are only applied to the selected element, in the current drawing. Standard files let 
administrators set the properties of an element so that they will be applied to all elements of 
the same type in a drawing, as well as in all drawings which use a given standard.
A standard file is an XML file which makes it possible to customize globally, for a CATDrawing, 
the appearance and behavior of drafting elements.
With standard files, administrators can:

set standard styles that will be used as default values when creating new elements, i.e.: 
� define sheet styles, geometry styles, annotation styles, dimension styles, dress-up and dress-up 

symbols styles, callout styles.
set standard parameters, i.e.: 
� control the user interface with general parameters to restrict the values of some element 

properties, customize dimensions, annotations, dress up elements, dimension tolerance formats, 
dimension value formats, dress up elements, etc.
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About Standards and generative View styles (2/2)

Generative view styles let you customize the appearance and behavior of a generated view via 
a set of pre-defined parameters and options. 
Administrators can create one or several generative view styles from which users can choose 
when creating a generative view. 
Generative view styles are defined in an XML file. 

By default, a pre-defined generative view style file is delivered. This file is located in 
install_root/resources/standard/generativeparameters/DefaultGenerativeStyle.xml.
Administrators can customize this file to define their default generative view styles. They can 
also use this file as a template for creating new generative view styles.
They can add as many generative view style files as needed. Refer to Administering Generative 
View Styles for more information.
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Administration of Generative View Styles and Standards (1/5)

Location of Standards files: The location of the Standards files is defined by two environment 
variables which can be set during installation or modified afterwards (need to be logged as 
administrator and need to start V5 in administration mode):

CATDefaultCollectionStandard: Path and name of the directory (or directories) which contains: 
� the generativeparameters sub-directories (which contain the predefined generative view styles

delivered by Dassault Systemes). 
� the drafting sub-directories (which contain the predefined drafting standards delivered by Dassault 

Systemes).
� The default location for this directory (set during the installation process) is the installation directory 

install_root\resources\standard.

CATCollectionStandard: Path and name of the directory (or directories) which contains:
� the generativeparameters sub-directories (which contain the customized generative view styles). It 

is in these generativeparameters sub-directories that you should add the generative view styles 
customized for a company, project or user.  

� the drafting sub-directories (which contain the customized drafting standards). It is in these drafting 
sub-directories that you should add the drafting standards customized for a company, project or 
user. 
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Administration of Generative View Styles and Standards (2/5)

Setting the location of generative view style files
There are two possibilities: 

If you want to place all customized generative view styles in a custom directory, named 
mydirectory for example, you need to proceed as follows: 

1. Create a directory named as you like (mydirectory, for example).
2. Create a sub-directory under this directory, which needs to be named generativeparameters. 
3. Place the XML files containing your customized generative view styles in 

mydirectory\generativeparameters.

If you have not yet customized your XML generative view style files, then proceed as follows: 

1. Create a directory named as you like (mydirectory, for example).
2. Create a sub-directory under this directory, which needs to be named generativeparameters. 
3. Set the CATCollectionStandard variable to mydirectory. After you have customized the XML 

generative view style files, the standard editor will then save them 
in mydirectorygenerativeparameters. 

If the CATDefaultCollectionStandard and the CATCollectionStandard variables both contain an 
identically-named generative view styles, it is always the style found 
in CATCollectionStandard which will be used.

If two directories referenced by the CATCollectionStandard and/or 
CATDefaultCollectionStandard variables contain identically-named generative view style files, 
it is always the style in the directory listed first which will be used.
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Administration of Generative View Styles and Standards (3/5)

Customizing and defining Standards (1/3)
Editing and saving Standards files in Tools/Standards is only allowed when you are running CATIA V5 
session in administrator mode (-admin).
The recommended method for customizing Standards files is the following:

launch the Environment Editor tool and create a new Environment called CATIA.V5R18.B16.admin 
(Global Mode)
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Customizing and defining Standards (2/3)

set up the CATReferenceSettingPath variable (use contextual menu on the variable)

set up the CATCollectionStandard variable (use contextual menu on the variable)

Administration of Generative View Styles and Standards (4/5)
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Customizing and defining Standards (3/3)

duplicate and/or modify the CATIA V5 shortcut icon using this new  Environment in administrator mode  
(-admin). Use Contextual menu on the icon.

then use this new shortcut to launch CATIA V5 Session in administrator mode in order  to customize 
Standards.

Administration of Generative View Styles and Standards (5/5)

"C:\Program Files\Dassault 
Systemes\B18\intel_a\code\bin\CNEXT.exe"  -admin 
-env CATIA.V5R18.B16.admin -direnv "C:\Document 
and Settings\All Users\Application 
Data\DassaultSystemes\CATEnv"

"C:\Program Files\Dassault 
Systemes\B18\intel_a\code\bin\CNEXT.exe"  -admin 
-env CATIA.V5R18.B16.admin -direnv "C:\Document 
and Settings\All Users\Application 
Data\DassaultSystemes\CATEnv"
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Setting standard parameters (1/3)

Structure of the Standard
A drafting standard file is structured as a tree, as it appears in the Standards Editor (available via 

Tools/Standards). It contains several main sections, each dealing with a specific aspect of drafting 
customization:
Styles 
General parameters 
Dress-up parameters 
Dimension parameters 

Company-defined dimension tolerance formats 
Company-defined dimension value display formats 
Pre-defined formats for tolerance and dimension values

Annotation parameters 
Company-defined view generation 
Company-defined frame formats 
Company-defined line thickness 
Company-defined patterns 
Company-defined line-types 
Company-defined sheet format



Student Notes:

Advanced Drafting and Customization
����������	��

Copyright DASSAULT SYSTEMES 94

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Setting standard parameters (2/3)

Use Tools/Standard command and select one of 
the international standards. Make your 
modifications and click Save As New button to 
save your new standard

When you enter the Drafting 
Workbench, choose your 
company Standard from the 
list.

You can update an 
existing drawing with 
your company standard 
using File/Page Setup
command. 

1
2a

2b

Creating a new company standard
Using Tools/Standard command you can create your own standard based on one of the default ones 
(ISO, ANSI, ASME or JIS)
This will create a new XML file in the install_directory\B16\\intel_a\resources\standard\drafting directory:
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Setting standard parameters (3/3)

Select Tools/Standards to launch the standards editor. Choose the 
drafting category, and then the ISO.xml file. Find the parameter to modify. 
You will find the detailed description of each parameter in the CATIA V5 
Online Documentation,  in Mechanical Design/ Interactive 
Drafting/Administrations Tasks/Setting Standard Parameters, e. g. add a 
new allowed text font size of 24mm.

Create a new ISO drawing. The new allowed text 
font size will appear in text font sizes combo box.

1

2

Customizing standard parameters
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Setting standard styles (1/2)

About Styles
Styles enable administrators to set the default 
values that will be applied to all properties of such 
elements as sheets, geometry, annotations, 
dimensions, dress-up and dress-up symbols, 
callouts, etc. 
The default values are defined and stored in the 
standard XML file, where a set of new parameters 
are defined, one parameter for each element 
property whose default value can be set. 
Default values are applied to elements as they are 
created. After creation, the user can modify element 
values as required. 
If you modify styles in the standard itself and then 
update the standard file used by the drawing, the 
elements which have already been created will NOT 
be modified (i.e. their default values will remain as 
previously). Updating the standard will only have an 
impact on the next elements to be created.
By default, one style named Default is predefined 
in the standard files for each type of element.
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Setting standard styles (2/2)

In the Style node select the Text node and click 
Create Style button. Type the name of the new 
style. A new style called ”MyStyle” is added 
under the Text node in the editor. Expand the Text node in the editor, 

and then select the Frame node. 
Choose Rectangle from the list

Start creating a new text in a sheet. In 
the Style toolbar, you can notice that 
two styles are now available: Default
and MyStyle. 

1

2

3

Customizing styles
You will see an example of how to create a new style for Texts. Note that a new style is always based on 
an existing style.
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Setting Generative View Styles (1/3)

You will find the detailed description of each 
generative view style parameter in the CATIA V5 
Online Documentation,  in Mechanical Design/ 
Generative Drafting/Administrations Tasks/Setting 
Generative View Style Parameters

Structure of the Generative View Styles
A generative view style file is structured as a 
tree, as it appears in the Standard Definition 
dialog box (available via Tools/Standards). It 
contains one section dedicated to generative 
drafting customization called 
DefaultGenerativeStyle/ Drafting
You will find two sub-sections:

Generate parameters: specifies whether 
the elements will be projected in the view 
or not. 
View dress-up parameters: defines the 
style of the various parameters which 
deal with the dress-up of the view. 
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Setting Generative View Styles (2/3)

Select Tools/ Standards to launch the 
Standard Definition dialog box. Choose the 
generativeparameters category, and then open 
the DefaultGenerativeStyle.xml file from the 
list.

Expand the node 
DefaultGenerativeStyle/Drafting/Generate/HiddenLines
and set the parameter value to Yes

2

3

Go to Tools/Options/ Mechanical Design/ 
Drafting/ Administration tab, and uncheck the 
Prevent generative view style creation option. 
This activates the generative view style 
functionalities. 

1

Customizing Generative View Styles 
You will learn how to customize generative view style parameters using a specific example. The 
pre-defined DefaultGenerativeStyle.xml file specifies that hidden edges are not visible and are in 
black color. You will modify these parameters so that hidden edges are always visible and 
displayed in orange.
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Setting Generative View Styles (3/3)

Create a front view. The 
view is generated, taking 
into account the new 
parameters you have 
defined.

5

Expand the node. 
DefaultGenerativeStyle/Drafting/View 
Dressup/GeneratedGeometry/HidenEdges
and set the color parameter to orange.

4

After the view creation you can still 
overload the generative view style  
in the Properties panel. In this case 
a star character is displayed.

6

Customizing Generative View Styles
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Administration Settings (1/4)

Select this option to make it impossible to create drawings using the File > New 
command. All drawings will be created using the File > New From... command instead.

1

2

3

4

1

Select this option to make it impossible to change standards, i.e. to use a standard 
other than the one currently defined in the Page Setup dialog box.

2

Select this option to make it impossible to update standards for the current document 
in the Page Setup dialog box.

3

Select this option to make it impossible to access the background view.
4

Drawing management
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Administration Settings (2/4)

Select this option if you want dialog boxes, Properties toolbars and the Tools Palette to be 
pre-filled with custom style values (as defined in the Standards Editor) when creating new 
annotations. In this case, Properties toolbars and the Tools Palette will be disabled during the 
creation of the annotation. If you leave this box unchecked, annotation dialog boxes, 
Properties toolbars and the Tools Palette will be pre-filled with the last entered values (except 
for Texts, Texts with leader, Balloons and Datum features). In this case, Properties toolbars 
and the Tools Palette will be active during the creation of the annotation. If you select this 
option, you will be able to reset the current style values in dialog boxes at any time using the 
Reset button unless it is disabled. 

1

This option lets you specify if the properties used for creating new sheets should be those 
defined in the standards or those defined in the first sheet of a drawing. These properties are 
the scale and the projection method (first or third angle). 

Select Style if you want the sheet to use the style defined in the standards (in Tools -> 
Standards -> Drafting -> [StandardName] -> Styles -> Sheet).

Select First sheet if you want the sheet to use the properties defined in the first sheet of a 
drawing. For example, you can use this option if you use an existing drawing to create a new 
one (i.e. when you want the new drawing to have the same properties as the existing 
drawing).

2

1

2

Style
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Administration Settings (3/4)

1
Select this option to make it compulsory to use User Defaults (i.e., user-defined values set as 
default). The Styles drop-down list will be set to Only User Defaults and will be inactive so that 
Original Defaults or User Defaults cannot be selected. 

This option applies only to drawings created with versions up to V5 R10 whose standard has 
NOT been updated or changed in V5 R11 and later. 

2

1

2

Select this option to use the current defaults and to make it impossible to create, change and 
reset user defaults (i.e. user-defined values). This disables the Set as Default and the Reset 
All Defaults commands.

This option applies only to drawings created with versions up to V5 R10 whose standard has 
NOT been updated or changed in V5 R11 and later.

Select this option to display the Reset button in dialog boxes. Deselecting this option hides 
the Reset button in dialog boxes and disables the Reset functionality.

3

3

Style
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Administration Settings (4/4)

1

1

2

2

Select this option if you do not want to use generative view styles when creating or updating views. 

Note that this option also drives view generation parameters when updating views, whether the view was 
created using generative view styles or not. In this case, there are two possibilities: 
• If you created the view using generative view styles (i.e. with this option selected) and then de-select this 
option, then, at the next update, the view properties (available via Edit -> Properties) will be used for all 
overloaded parameters (an asterisk * appears in the Properties dialog box in front of the parameters which 
are considered as being overloaded) and the view settings (available via Tools -> Options -> Mechanical 
Design -> Drafting - > View tab) will be used for the others. 
• If you created the view without generative view styles (i.e. without this option selected) and then select 
this option, then, at the next update, all parameters available in the view properties  will be used. To make 
sure that generative view styles are used in this case, click the Reset to style values button in the 
Properties dialog box. 

Select this option to make it impossible to modify a 3D constraint via a 2D dimension that was generated 
from it.



Student Notes:

Advanced Drafting and Customization
����������	��

Copyright DASSAULT SYSTEMES 105

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Increasing Productivity
You will become familiar with …

Generating Hole Dimensions Tables
Creating Point Coordinates Table
Creating a Table
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Generating Hole Dimensions Tables

For threaded holes, the diameter is the 
hole diameter and not the thread 
diameter.

You can choose the 2D axis system of the 
view or define an other one interactively by 
selecting a point, two lines or indicating a 
point by clicking in the view.

You can specify 
the way to sort 
the table.

You can set the 
first label value 
used to reference 
the holes.

There is no associativity with the 3D data, if you make modification 
on the holes, you need to delete the table and regenerate a new one.

You have the capability to generate a table which contains holes coordinates according to 
a specific origin.
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Creating Point Coordinates Tables

In this case, you can also choose the 3D axis 
system (in this case it is the absolute axis of 
the 3D model), or if the model is a single part, 
you can choose a local axis.

There is no associativity with the 3D document. If 
you make modification on the holes, you need to 
delete the table and regenerate it.

You have the capability to generate a table which contains points coordinates according to 
a specific origin.



Student Notes:

Advanced Drafting and Customization
����������	��

Copyright DASSAULT SYSTEMES 108

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Creating Tables

Remark1: you retrieve the same 
properties than the Text concerning 
snapping and positional capabilities.

Line Height depends on the text size 
set in the Text Properties toolbar and 
Line Width is 5 times ones text size.

You can double-click the table to edit it. You 
can select rows and columns and modify 
them by using the contextual menu.

When the table is in edition mode, you can 
not move it anymore.

You can multi-select cells and 
access a contextual menu to merge 
cells or insert view in the cells.

Remark2: you can import CSV Table.

You can create a Table and add in it texts and views. You will be able to 
insert columns, rows, merge cells, invert lines, invert columns or switch 
lines and columns.
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Creating Frames & Title Blocks with a 
Macro
You will become familiar with …

Defining Frames
Filling in the Title Block
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Standard title block macro
You have the possibility to use a VBscript macro to generate Title Blocks automatically adjusted to 
your drawings formats.
You can access different styles of Title Blocks using the Frame Creation function.
This macro allows you to create, delete, resize or update title Blocks and to add some information 
like the name of the person who checks the drawings and the revision blocks.

Defining Frames (1/14)
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Defining Frames (2/14)

The title block macro is delivered with CATIA V5. You will find it in the 
install_root/intel_a/VBScript/FrameTitleBlock directory.

We will explain in the following pages the macro instructions that generate the frames
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Defining Frames (3/14)

height

width

offset

reference

border

centering mark

ruler

Title Block border

Frame text

Title Block standard
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Defining Frames (4/14)

First of all, you need to activate the sheet and 
the view of your drawing if you want to create 
here the Title Block.

Here is the way to 
define main variables.

How to init the dialog and create main objects
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Defining Frames (5/14)

How to define frames overall dimensions
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Defining Frames (6/14)

You have to create a reference Text which will be 
used to check if you can make some actions like 
delete, update or resize on the existing Title 
Block. This Reference Text will identify the 
macro used to create the existing Title Block of 
your drawing.

If you want to add a new macro to create your 
customized Title Block, you have to rename the 
MacroID variable like the macro name.

When you want to 
make an action 
on an existing 
macro, a test will 
look for the using 
Reference Text. 

How to define a reference text and check that the called macro is the right one
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Defining Frames (7/14)

The frame is composed of a border, 
some centering marks, letters and a 
ruler.

Standard values.

Cst_1

Cst_2

Nb_CM_V

Nb_CM_H

Nb_CR

How to create the frame
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Defining Frames (8/14)

This subroutine allows to compute 
the standard values in relation to the 
drawing format and orientation.

How to define standard values in relation to the sheet format
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Defining Frames (9/14)

All the lines are created by using the 
reference as origin point.

Frame_Border_Bottom

Frame_Border_Top

Frame_Border_Left

Frame_Border_Right

How to draw the frame border



Student Notes:

Advanced Drafting and Customization
����������	��

Copyright DASSAULT SYSTEMES 119

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Defining Frames (10/14)

How to draw centering marks
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Defining Frames (11/14)

How to add texts around the border frame
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Defining Frames (12/14)

How to create a ruler
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Defining Frames (13/14)

How to create the title block
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Defining Frames (14/14)

How to draw the title block frame
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Here the example of a subroutine 
just for adding a text to indicate the 
company name.

Filling in the Title Block (1/4)

How to add texts
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Filling in the Title Block (2/4)

The subroutine which adds Text Boxes in the 
Title Block can directly fill in several information 
from the 3D like the Definition, the PartNumber, 
the weight, etc…, or from the drawing like the 
size, the scale, the sheet number or the format.

How to add texts linked to 3D information
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Filling in the Title Block (3/4)

The subroutine which add Text Box in the Title 
Block can directly fill in information from the 
operating system like the creation date or the 
user name.

If you want, you can always modify these 
information by editing the text box in the 
background view.

Be careful, USERNAME is only a windows environment 
variable.

How to add texts linked to the operating system
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Filling in the Title Block (4/4)

You can add title box texts using the 
VBscript function Input box which 
asks user to key in a value in a 
specific panel.

You need to identify the text id you want 
to modify then you will replace its value 
by the value specified in the input box 
panel.

Properties

How to add texts using inputbox function
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To Sum Up

In this course you have seen :

Hints & Tips on Dimension commands
Hints & Tips on Text commands
Drawing Generation from large assemblies
Managing Standards
Generating Specific Views
Generating Dimensions
Filtering Techniques in Generative Drafting
Using VBScript macro to generate Title Blocks


